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Section 1. Introduction 

About The Document 

This document introduces you to Maple 11. It is designed for beginning users of the 
Maple application. In order to make use of this document, you should have a basic 
knowledge of calculus, linear algebra, and differential equations.  The document is 
organized into 8 sections. The first section provides a brief introduction to Maple. The 
second section gives an overview of the Maple Windows Development Environment and 
its basic conventions. The third and fourth sections explain how to use Maple to do 
numerical and symbolic computations. The fifth section covers the graphics functionality 
of Maple, including 2D plotting, 3D plotting and animation. The sixth section shows how 
to use Maple to solve Calculus problems. The seventh section introduces linear algebra in 
Maple. The eighth section concludes the document with information about where to get 
further help and resources about Maple. 

Maple Introduction 

Maple” is a mathematical software package for symbolic computation. Conventional 
mathematical software packages usually require numerical values for all variables. In 
contrast, Maple can evaluate both symbolic and numerical expressions. 

Maple was first developed at the University of Waterloo, Canada in 1980. The objective 
was to design an algebra software for the researchers and students in Mathematics, 
Engineering, and Science.  It was initially implemented in B on a Honeywell computer 
and soon was switched to C, one of the most popular programming languages.   

In 1988 Waterloo Maple Software was founded to directly sell and further improve the 
Maple system. Currently, the version formally supported by ITS and SSC is Maple 11.  
Maple is a computer software program for advanced mathematics. It is available for a 
wide variety of platforms including Windows, UNIX and Linux. It includes utilities for 
algebra, calculus, discrete mathematics, graphics, numerical calculation, and many other 
areas of mathematics. It also provides a unique environment for rapid development of 
mathematical programs using its vast library of built-in functions and operations.  

 

Section 2. An Overview of Maple 

Access to Maple   

Information Technology Services (ITS) at UT-Austin provides free Maple access to 
students, faculty and staff via the desktop computers in the Student Microcomputer 
Facility (SMF) on the second floor of the Flawn Academic Center (FAC 212).  Before 
you may use these machines, you must have a University EID or a departmentally-
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sponsored account issued from ITS.  A basic account that can be used in the SMF has no 
cost, though there will be some service charges if optional validations are desired.  
Information about getting an ITS- issued account is available at: 

   http://www.utexas.edu/its/account/ 

Maple 11 is installed on the two ITS UNIX systems running on the Solaris 8 operating 
system: ccwf.cc.utexas.edu and uts.cc.utexas.edu.  A Windows version of Maple 11 is 
installed on the ITS Windows terminal server, wts.austin.utexas.edu.  To access these 
installations, an ITS-issued account must have UNIX Timesharing System(ccwf and uts), 
or Windows Terminal Services validation (austin).  These mainframe validations require 
a minimum of 5000K disk storage, costing 3 cents per day. 

Maple licensing through UT Software Distribution Services has been discontinued. 
Licenses can be obtained directly from the vendor. Pricing and other information about 
Maple is available at: 

      http://www.maplesoft.com/ 
 

Getting Started  

The Maple launch method varies for different operating systems:  

• On a Macintosh: Start Maple by double-clicking on the Maple icon. Maple will 
start up with an empty worksheet. To begin using Maple, type commands at 
Maple's prompt ">" in the command window. Alternatively you can start Maple 
by double-clicking on a previously saved Maple worksheet, in which case Maple 
will automatically open that worksheet when it starts up.  

• On a PC running Windows: Start Maple by double-clicking on the Maple icon. 
This will start up Maple with a blank worksheet. You can then begin typing 
Maple commands at the Maple worksheet prompt.  

• On a Unix machine: The Maple executables are not in the default command 
search path. You can add this directory manually to your path. If you are using the 
C-shell, type:   

        setenv PATH /usr/local/maple/bin:$PATH 
 
If you are using the Bourne shell, type: 
 
         DISPLAY=/usr/local/maple/bin:$PATH; export PATH  

The command above can be put at the end of your .cshrc (or .profile) so that it 
will be executed automatically. (Note: issue this command only after you have set 
your environment variables such as PATH and MANPATH.) 
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To start the command line implementation of Maple, type:  

       maple 

An X based version of Maple is also available. To run the X based version 
of Maple you must first allow the system on which you are running Maple 
to connect to your workstation or X-terminal. To do this, type:  

        xhost + Unix machine name 
 
on your local workstation. Next, set the DISPLAY environment variable 
to point to your workstation or X-terminal. If you are using the C-shell, 
type:   

        setenv DISPLAY your local machine name:0 
 
If you are using the Bourne shell, use:  

        DISPLAY=your local machine name:0; export DISPLAY 
 
then you may run the X version of Maple by executing the command:  

      xmaple & 
 
When Maple begins running, it will automatically execute the commands 
in the file .mapleinit in your home directory, if it exists.  

 

The Maple Window 

 

        After Maple is started, we usually can see a window similar to that in Figure 1.This 
is Maple's worksheet-based graphical interface. A worksheet is a document for 
implementing and saving mathematical operations. In the worksheet, you can enter 
Maple commands. By default, Maple input is displayed in black type, with a Courier font, 
and text input is italic. The Maple numeric or symbolic output is displayed in blue type in 
standard math notation, and a simple plot line is displayed in red. 
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 Figure 1. The Maple Window  

  

At the top of the Maple window is a menu bar. It provides different options for you to 
save or edit  the Maple session. For example, clicking on the File menu and selecting 
Save will allow you to save your current worksheet for later use; selecting Open from the 
same menu allows you to load an existing worksheet. Below the menu bar is a collection 
of buttons, which are short-cuts for items found on the various menus. Clicking on one of 
these is much quicker than searching for the command on the menu. For example, the 
button that looks like a floppy disk ( ) saves the current worksheet. Below the shortcut 
buttons is the context bar, which changes depending on what kind of item you currently 
have selected. For example, when graphics are selected there are buttons to adjust the 
graphics styles. 

 

The Help Window 

Maple 11 has an extensive online help system to help you understand its language, 
procedures, and syntax. Each help page has a set of examples at the end. You can test the 
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Maple commands by copying an example from a help page and pasting into the 
worksheet window.  

There are a few ways to get into the help system. One obvious one is to select from the 
Help menu. If you are a new user, you may wish to choose Help > Take a Tour of Maple 

which provides information to help you get started. After selecting Help > Maple Help, 
there is search area from which information can be found with topic or text keys. Besides 
the help menu approach, there is another quick way to find help information.  If you 
know the help topic in advance, you can issue a Maple help command with the ?syntax 
directly from a Maple worksheet. For example, ?solve will show you the solve() function 
help information.  

The help window has two panes. The left pane contains the Help Navigator, while the 
right pane displays the help page (see Figure 2 for an example). In the help navigator, a 
folder icon indicates that a topic can be expanded into subtopics. Clicking a topic 
preceded by a dot icon displays the associated help page. You can use this to browse for 
commands you might not otherwise have known about. 

 

Figure 2.  Example from Maple Help  
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Basic Conventions in Maple  

Enter A Command 

Using Maple to enter and execute a command is very simple: merely input the command 
at the Maple prompt. When you press "Enter", Maple will execute the input and the result 
will be shown on the line below, in the center of the screen. The following example 
shows a simple numerical calculation. After you type 1+2; and hit the return key, the 
result 3 will be shown in the center of screen. 

Example: Entering and executing a command 

>  
 

Arithmetic Operators of Maple  

The arithmetic operators of Maple are defined as follows in Table 1:  

Table 1 

 

Operations  
 

Arithmetic 

Operators  

 

Examples  

 
Addition 

Subtraction 
Multiplication 

Division 
Exponentiation  

 
+ 
- 
* 
/ 

^ or **  

 
1+2 
x-y 

54*4 
x/y 

2^3 or 2**3  

The precedence order of the Maple arithmetic operators is the same with the order of 
mathematical arithmetic operators. Parentheses could be used for grouping to manipulate 
the operational order. For example, (89-9)*2 first calculates 89-9, then performs the 
multiplication (89-9)*2. Without the parentheses, 89-9*2 will first calculate 9*2, then do 
the subtraction 89-9*2.  

 Referring to Previous Results and Adding Comments  

In Maple, percentage signs are used to refer to previously computed expressions. 
Specifically, the following operators are defined: 

            %         Most recent 
            %%      Second most recent 
            %%%   Third most recent 
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The example below shows how we can use the percentage signs to simplify numerical 
calculations. For each step, we also insert comments using the pound sign # : all 
characters that follow the pound sign # are considered as comments. 

Example: Using percentage signs to refer to previous computed results  

>  
 

 

>  

 

>  

 

 

>  
 

 Defining An Expression Using :=  

Most calculations in Maple will involve defining expressions. An expression is a 
combination of number(s), variable(s) and/or mathematical operator(s).  To define an 
expression, you assign it a name using the convention name:=expression.  In this way, 
whenever you want to use the expression, we can directly use the name without retyping 
the expression. The example below assigns the name, expression1, to the expression 
x^2+x+2.   

 Example: Defining the expression x^2+x+2; 
 

>  
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How to Handle Mistakes 

If you accidentally type incorrect syntax in the command line and hit enter, Maple will 
respond with a syntax error. There are two ways to fix your error. You can go back, 
change the Maple command, and re-execute it; when Maple re-executes the command, 
the result will change. Or you can type restart; to clear the old information and then type 
in the correct Maple commands.  

Basic Data Structures In Maple  

The most fundamental data structures in Maple are expression sequences, lists and sets. 
They are commonly used as parameters in Maple commands.  

Expression Sequences  

An expression sequence is one or more expressions separated by commas. The simple 
way to create an expression sequence is to enter it directly. Enter the expression sequence 
at the prompt. Separate each element in the sequence with commas 

 
Example: Creating an expression sequence  

>  
 

 

>  
 

Alternatively, the seq() function can be used to create an expression sequence. It operates 
very quickly and improves the efficiency of your Maple program. In order to generate the 
sequences f(m), f(m+1), f(m+2),... f(n), you would type:  

•         seq(f(i),i=m..n)   # f represents an expression with the index of i  

In the following example, f is i2. We use the seq() function to create the expression 
sequence f(2), f(3) and f(4).  

Example: Creating the expression sequence of the square of i using seq() function 

>  
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Lists and Sets 

Lists and Sets are usually used as the arguments of functions. Expression sequences are 
used within Lists and Sets. A list is an expression sequence enclosed in square brackets. 
It preserves the order and repetition of elements in a list. In the following example, we 
create a list, [1,1,3,5,5] by enclosing the expression sequence 1,1,3,5,5, in square 
brackets. We then name it as list1. We can see list1 preserves the list order and repeated 
elements. 

Example: Defining a List 

>  
 

A set is an expression sequence enclosed in curly braces. It doesn't preserve order or 
repetition of elements. Thus, a Maple set has the same properties of a Mathematical set. 
For example, we define set1 and set2 with different expression sequences inputs. 
However the loss of order and repetition results in identical sets.      

Example: Defining a Set 

>  
 

 

>  
 

 
 
 

        Section 3. Numerical Computation 

Maple can do floating point, integer and complex numerical computations.  

 

Floating Point Number Computation 

One of the important Maple properties is the ability to do exact arithmetic: rational 
numbers are not reduced to floating point approximation. In this way, round-off error can 
be avoided.  

Example: Computation Without Round-off Error 
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>  

 
 

If an approximate result is needed, the evalf function can be used to convert an exact 
numerical result to an approximate floating point number result.  

Example:  Converting an exact numerical result to a floating point number  

>  
2.325000000 

Or you can include float number(s) in an expression and it will automatically cause 
Maple to produce an approximate floating point result.  

Example: Using a floating point number inclusion to create floating point number result 

>  

2.325000000 

Integer Computations 

Maple can work with arbitrarily large integers. If a number is too big and spans more 
than one line on the screen, a backslash can be used to indicate the number is still 
continuous. 

Example: Working with large integers.  

>  

10000000000000000000000000000000000000000000000000000000000000000000000\
000000000000000000000000000000 

Complex Number Computation   

When Maple does complex number calculations, a capital I is used to represent the 
square root of minus one.   

Example:  

>  
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 Built -In Functions and Constants  

Maple has many built-in standard functions and constants, which can be applied when 
doing numerical calculations. The commonly used numerical functions and constants are 
shown in the following Table 2 and Table 3.  

 

Table 2. Selected Built-In Mathematical Functions       

sin(),sinh() Sine and hyperbolic sine 

cos(),cosh()  Cosine and hyperbolic cosine 

tan(),tanh()  Tangent and hyperbolic tangent 

sec(),sech()  Secant and hyperbolic secant 

csc(),csch()  Cosecant and hyperbolic cosecant 

cot(),coth()  
Cotangent and hyperbolic 

cotangent 

exp()  Exponential 

ln()  Natural logarithm 

log()  Natural logarithm (same as above) 

log[b]()  Log to base b 

abs()  Absolute value 

sqrt()  Square root 

 

Table 3.  Built-In Constants  

Pi  math constant pi; evalf(Pi) is approximately 3.14159265... 

I   I^2 = -1; used for complex number representation 

infinity name for infinity; used by some functions 

true  the value true in the context of Boolean evaluation 

false  the value false in the context of Boolean evaluation. 
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gamma   Euler's constant. evalf(gamma) is approximately 0.5772156649... 

 
 
 

Section 4. Symbolic Computation  

The heart of Maple is symbolic computation. By allowing the variables to remain 
unknown, Maple can provide exact analytic solutions. Symbolic computations usually 
involve expressions, functions, or equations and in Maple there are many functions for 
symbolic computations.  

Symbolic Computations on Expressions  

Maple has many functions for symbolic expression computation. Here we will introduce 
the most commonly used expression manipulation functions.  

Simplifying An Expression 

The simplify function tries to find a simpler equivalent of an expression by applying 
simplification rules.  The simplification rules include trigonometric functions, 
logarithmic functions, and exponential functions.   

Example: Simplifying an expression (sin(x))^2*(x^5)+(cos(x))^2*(x^5) 

>  
 

If you specify a simplification rule as an argument to the simplify function, then Maple 
uses only that simplification rule. In the example below, we require that the natural log be 
used to simplify the expression.  
 
Example: Specifying simplification rule 

>  
 

Expand An Expression  

The expand function causes expansion of multiplied terms as well as a number of other 
expansions. Expansion does not always cause the original expression to become more 
complicated. In contrast, it can result in simplifications in many cases.   

Example: Expanding a polynomial expression  
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>  

 

 

Factor An Expression  

This function is the opposite of the expansion function. It factors polynomial expressions.  

Example: Factoring a polynomial expression   

>  
 

 

Normal Function 

If an expression contains fractions, it may be useful to restructure the expression as a 
large fraction by canceling out common factors in the numerator and denominator. The 
normal function implements this process.  

Example: Using normal  to simplify an expression  

>  

 

Equations  

Defining Equations  

Equations are defined by using the ' =' sign, in contrast to the ':= ' sign, which is used to 
assign a name to an expression.  

Example: Define an equation x=y+2  

>  

 

Solving Equations  
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The solve() function is one of the most commonly used equation solvers. It can be used to 
solve a set of equations and gives exact solutions to equations with rational coefficients. 
To use the solve function, you need to provide two elements: First, the equation(s) you 
wish to solve (e.g., x1+x2=5/6 and 2*x1+5*x2=7/8), and second, the variable(s) you 
wish to solve (e.g., x1 and x2). If you have more than one equation to solve (e.g., 
x1+x2=5/6 and 2*x1+5*x2=7/8), you need to define the equations and the variables as 
sets (e.g., {x1+x2=5/6, 2*x1+5*x2=7/8} and {x1,x2}) 

Example: Solve equations using solve and get exact solutions 

>  

 

However, the solve function cannot solve all problems. Mathematically, a set of 
equations involving polynomials of degree five or higher do not in general have a 
solution in terms of radicals. In such cases, Maple will attempt to solve the equations and 
display the solution if it finds one.  

The fsolve function is the numeric equivalent of solve. It gives approximate floating point 
solutions to equations using Newton's method. If a set of  equations involves 
polynomials, then approximations are given for all real solutions. For non-polynomial 
systems of equations, usually only one solution is given. 

Example: Solve equations using fsolve and get an approximate float number solution  

>  

 

  

Functions 

Defining a Function With One Variable 

A function is a procedure that returns a value specified by a set of variables. In Maple, we 
use the arrow character "->", i.e., a hyphen followed by a right angle bracket, to define a 
function. A function can be assigned a name using the ":=" characters, in the same way 
you would name an expression. In the example below, the function is named as f and has 
only one variable x. In the f function, f(x)=x

5
+6x. 

Example: Defining a function f(x)=x
5
+6x  

>  
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To evaluate a function, type the function name and the value of the variable. Use the f(x) 
format where f is the function name and x is the variable to be set. 

>  
 

Defining a Function With Multiple Variables 

A function with multiple variables is defined much like a one-variable function. The only 
difference is that the function with multiple variables will have more dependent variables. 
In the example below, the function is named as f and has two dependent variables, x and 
y. For example we could define the multiple variable function  f , where f(x,y)=x

2
+y

2. 

>  
 

To evaluate a function, type the function name and the values of the variables. The 
example below evaluates the function f(x,y) when x=1 and y=1. 

>  
 

 
 

Section 5.  Graphics 

Maple has powerful graphics capability. It can generate both multiple-dimensional plots 
and animations. 

Two-Dimensional plots  

The function plot() generates a two-dimensional plot and it is the most commonly used 
plot function in Maple. It can be used to plot expressions, functions, and data sets. 

Plot An Expression     
  
When Maple plots an expression, the range of the argument must be given. Use the 
keyword plot, then enclose the expression and the range of the argument within 
parentheses. 
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Example: Plotting the expression x3
+5x

2
 over the interval [-10, 10]. 

 

>  

  
    
 

  

When the plot appears, click your left mouse button (or the equivalent on a non-Windows 
platform) on the plot -- you should see a box around the plot and new icons on the 
context bar. You can adjust the plot style by clicking the new icons. To see the 
coordinates of any point on the plot, move the point probe cursor using the mouse to the 
point. The point's coordinates will appear in a box on the context bar. In addition, you can 
also export your plot as a ".gif" or ".jpg" file  by clicking the right mouse button and 
choosing Export > Graphics Interchange Format or Graphics > JPEG Format 

respectively. 

Plot A Function   

Plotting functions is very similar to plotting expressions. The main difference is that you 
have to define the function before calling the plot() function.  That is, you need to first 
define a function. Then plot the function using the plot command, enclosing the function 
name and the range of the argument in parentheses. 

Example: Plot the function  f(x)= x
3
+5x

2 over the interval [-10,10]   

>  
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We will obtain the same result as was obtained in the previous example.  

Plot Data Set 

 

The plot() function can also be used to plot a data set: first define the data set as a list, 
then plot the list.  

In the example below, we define a list called data. The list data is created by the 
expression sequence [3,4],[5,6],[7,8],[9,10] . Each element of the expression sequence 
itself is also a list, corresponding to a point's coordinates. We then plot the list data using 
the plot command. If you want to specify a plot's style, you can also add an optional 
argument to plot(). The plot() function has three different styles: point, line, and patch. 
The default style is line. In this example, we specify the plot's style as point. 

Example: Plotting the dataset data 

>  
 

>  

  

  

 

Three-Dimensional Plots 

The three-dimensional plot function, plot3d(), is another basic graphic function. It can be 
used to plot both expressions and functions. In plot3d, you will have two domains and 
will need to define the ranges of both arguments.  



19 

Plot An Expression   

Example: plot the expression xy over the interval x=[-10 10] and y=[-10 10] 

>  

 

  

When the plot appears, click your left mouse button (or the equivalent on a non-Windows 
platform) on the plot -- you should see a box around the graphic and new icons on the 
context bar. By clicking on the new icons, you can change the plot style. You can also 
click the right mouse button and select a format from the Export menu selection to export 
your plot as a ".gif" or ".jpg" file. 

Plot A Function  

Before plotting functions, the function needs to be defined. If the function f(x,y) involves 
x and y, the range for the x-values and the y-values should be specified.  
 
Example: Plot the function f(x,y)=x^3+y^4  
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>  

 

 

>  

 
  

 
 

 

  

Multiple Plot Display  

We often like to display several graphs at the same time. One way to do this is to give the 
plot function a list of expressions or functions to display at the same time. List the set of 
expressions or functions first, then list the range. If you would like the plots of the 
different expressions to be differentiated by color, you can use the keyword color to 
define the plot's colors in respective order.     

Example: Multiple Plot Display  

>  
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Another way to generate multiple plots is to use the display command in the plots 
package. Maple packages provide extra functions to Maple. To load any Maple package, 
use the with command. 

• First load the plots package      

>  

 

• Then name the plots to be displayed. In this example, we name the two plots 
graph1 and graph2  

>  

>  

 
            Note that the colon after each command is important. If you type a semicolon  
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            instead, you will see a list of the data that are created during the execution  
            of the plot() command.  

• Display the named graphs together using the display command  

>   

          We then get the same figure as was obtained previously. 

 

Animation 

Animation displays a number of frames in sequence. There are two basic animation 
functions defined in Maple. They are animate and animate3d.  Before using them, we 
must load the plots package via the command with(plot).   

Two-dimensional Animation 

animate() is used for two-dimensional animation. It has one frame variable, t, and one 
dependent variable, x. The frame variable t changes for each frame and the dependent 
variable x defines the function argument range in each frame.  

Example: Create a 2-D animation  

>  
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When you start the animation, Maple displays the first frame. To play the animation, 
click on the animation frame. A set of new icons will appear on the context bar. Click the 

Play button  to play the animation. You can also use the other options to change the 
animation style. For example, you can play the animation continuously by selecting the 

cycle-mode button  on the context bar. By default, a two-dimensional animation 
consists of 16 frames. If the motion is not smooth, you can increase the number of frames 
by using the frames option.  In the following example, we use the frames option to 
change the number of frames to 30. It should be noted that computing more frames 
requires more time and memory. 

Example: Changing the Number of Frames 
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Three Dimensional Animations 

animate3d() is used for 3-dimensional plot animation. It has one frame variable, t, and 
two dependent variables, x and y. The frame variable t changes for each frame and the 
dependent variables x and y define the function argument range in each frame.   

Example:  

>  
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By default, a three-dimensional animation has 8 frames. We can also use the frames 
option to change the frame number. 

 
 
 

Section 6. Calculus 

Differentiations 

There are two differentiation operations, diff and D in Maple. diff computes the 
derivative of an expression, and its output is an expression. D computes the derivative of 
a function, and its output is a function. 

diff() Function 

The diff function can be used to compute both first and higher-order derivatives. To 
request a higher-order derivative, use the $ sign followed by the order of the derivative.  
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• diff(expr,x)               #Computing the derivative of the expression expr  
                                 # with respect to x  

• diff(expr,x$i)           #Computing the ith-order derivative of the expression 
                                 # expr with respect to x  

  

Example: Computing the derivatives of expression expr  

>  
 

>  

 
 

>  

 

 

>  

 

The diff function can also be used to compute multiple-variable derivatives.  

• diff(expr, x1,x2,x3,...,xm);            #computing the partial derivative of an  
                                                   #expression expr with respect to  
                                                   # x1,x2,...xm respectively.  

• diff(expr,x1$n1,x2$n2,..xm$nm); #computing the n1th-order partial derivative  
                                                  #of the expression expr with respect to x1, 

                                                  # the n2th-order partial derivative of expr  
                                                  # with respect to x2..... and the nmth-order  

                                                  # partial derivative of expr with respect to xm  

Example: Computing Multiple-Variable Derivatives 

>  
 

 

>  
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>  

 

  
 

D Operator 

The D operator can be used to compute the derivatives of both multiple-variable and 
single-variable functions.  If a function f has only one argument, we can use: 

• D(f)             # Computing the first-order derivative of function f  
• D[1$n](f)    # Computing the nth-order derivative of function f  

Example: D operator for single variable function  

>  
 

 

>  

 

 

>  
 

 
If a function f has n arguments, we can use: 

• D[i](f)                  #computing the partial derivative of  function f  
                            #with respect to its ith argument.  

• D[i$n](f)             #computing the nth-order partial derivative of  
                           # function f with respect to the ith argument  

• D[i1,i2,..im](f)     # computing the partial derivative of function f 
                          # with respect to the i1th argument, the i2 th argument, ... 
                          # and the im th argument respectively.  

• D[i1$n1,i2$n2,..im$nm](f)   #computing the n1th-order partial derivative  
                                         #of function f with respect to the i1th argument,  
                                         #the n2th-order partial derivative of function f 
                                         # with respect to the i2 th argument, the nmth-order  
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                                         #partial derivative of function f with respect  
                                         # to the imth argument.  

Example: D operator for multiple-variable functions  

>  

 

 

>  
 

 

 

>  
 

 

>  

 

 

>  

 

 

>  

 

 

 

Integrals  

Maple can compute both definite and indefinite integrals. The same function int() is used 
in both cases, but with different syntax.  
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Indefinite Integrals  

• int(exp,x) is the syntax used for computing the indefinite integral  
                of the expression exp with respect to the variable x.  

Example: Compute the indefinite integral of  x*exp(x) with respect to x  

>  
 

 

>  

 

Definite Integrals  

• int(exp,x=a..b) is the syntax used for computing the definite integral  
                        of the expression exp with respect to the variable x 
                        between the interval [a,b].   

Example: Compute the definite integral of 1/(1+x^2)  
               with respect to x over the interval [0, 10]   

>  

 

 

>  

 
 

>  
 

 

Example: Compute the definite integral of exp(x)*y  
               with respect to x over the interval [0, 2]    

>  
 

 

 

>  
 



30 

Differential Equations  

In Maple, the dsolve() function is used to solve different kinds of ordinary differential 
equations(ODEs).  

Solving A Single ODE  

To solve an ODE, first specify the ODE equation, then use the dsolve command to find 
its solution. The dsolve() function is defined as: 

• dsolve(ODE,y(x));  #computing the y(x) general solution for the ODE.   

  

Example : solve  y''-2y'=sin(x).  Here y'' means the second-order derivative of y  
                with respect to x and  y' means the first-order derivative of y  
                with respect to x. 

>  

 

 

 >  

 

Here, _C1 and _C2 are arbitrary constants and any real _C1 and _C2 constitute a solution 
to the differential equation. These constants can be determined by initial conditions, 
which are implemented as follows: 

• dsolve({ODE,init-cond},y(x)) computes the solution y(x) for the ODE to 
                                                  conform with the initial conditions.   

To specify the initial conditions for the derivative of a function, use the following 
notation. 

• D(fcn)(var_value)=dvalue;              #D notation represents the derivative; 
                                                          # When the variable value is var_value,  
                                                          # the derivative of fcn is dvalue  

• (D@@n)(fcn)(var_value)=dvalue;   #D@@ notation represents the nth-order  
                                                          #derivative.When the variable value is  
                                                          #var_value, the nth-order partial  
                                                          #derivative of fcn is dvalue  
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Example: Solving an ODE With Initial Conditions.  
 
Consider the ODE equation  y''-2y'=sin(x) with initial conditions, y(0)=1, y'(0)=1 

>  

 

 

>  
 

 

>  

 

 

Limit Function  

Maple uses the function limit() to compute an expression's limit. limit(expr,x=a,direction) 
tries to compute the limiting value of expression expr as x approaches the value a. The 
direction parameter is optional. It can be right, left, real, or complex. If direction is not 
specified, it means the limit is the real bi-directional limit. However, if the limit point x is 
infinite, it means the limit point is from the left to infinity; if x is negative infinite, it 
means the limit point is from the right to negative infinity.  

Example: Find a limit 

>  

 

 

>  

 

 
>  
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Section 7. Linear Algebra  

Vectors  

Definition  

A vector in Maple is a one-dimensional array whose indices start from 1. The vector() 

function is used to define a vector in Maple. It is part of the linalg package. There are 
several ways to define a vector:   

• vector([x1,x2...xn]) or vector(n, [x1,x2,...xn]);  #Creating a vector of length n  
                                                                         #containing the given elements  
                                                                         # x1,x2,...xn .   

• vector(n);  # Creating a vector of length n with unspecified elements.  

Example: Defining the vector a with specified elements 1,2,3,4,5  

>  

 
>  

 

 

Example: Defining the vector b with specified elements 1,2,3  

 

>  
 

Example: Defining the vector b with 4 unspecified elements  

>  
 

If a vector v1 is defined, we can access the nth element of the vector v1 by typing v1[n].   

Example:  Access the 2nd element of vector a  

>  
 

>  
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Vector Algebra 

The commonly used algebra operations on vectors are as follows: 

• evalm(c*v1);           # Multiply each element of the vector v1 by scalar c  
• evalm(v1+v2);         # Sum of the vector v1 and v2 (v1 and v2 must  

                                 # have the same length).      
• evalm(v1-v2);          # Difference of  the vector v1 and v2 (v1 and v2  

                                 # must have the same length).        
• dotprod(v1,v2);        #Dot product of the vector v1 and v2  

                                 # (v1 and v2 must have the same length).   
                                 #Sum the v1[i]*v2[i], as i ranges over  
                                 # the length of v1 and v2      

• crossprod(v1,v2);     # (v1 and v2 must be 3-element vectors). The cross product  
                                 # of vector v1 and vector v2 is defined: 
                                 # [v1[2]*v2[3]-v1[3]*v2[2], v1[3]*v2[1]-v1[1]*v2[3], 

                                #  v1[1]*v2[2]-v1[2]*v2[1]].     
                                                                   

Example: Define the vectors v1 and v2. Multiply each vector by a constant. 

>  

 
 

>  

 
 

>  

 

 

>  

 

Example: Calculate the sum and difference of the vectors v1 and v2  

>  
 

 

>  
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 Example: Calculate the dot product of the vectors v1 and v2  

>  

 
    

 Example: Calculate the cross product of the vectors v1 and v2   
 
>  

 

 

Matrices 

Matrix Definition 

A matrix in Maple is a two-dimensional array with row and column indices starting from 
1. Matrices are defined in two ways:  

• A:=array(1..m,1..n); # A matrix with m rows and n columns  
• A:=matrix(m,n,[..list f elements..]);#a matrix with m rows and n columns 

                                                         #with specified elements  

The function matrix() is part of the linalg package. In the example below, we first load 
the linalg package. Then we define a matrix A with two rows and two columns, 
containing the values 1,3,5,4. 

Example: Defining a Matrix 

>  

 
>  

 

 

The elements are read sequentially and inserted row by row.  

Row and Column Operations On Matrix 

 

The general row and column operations on a matrix are as follows: 
(Here we suppose that A is a matrix, and that  ri and rj are its i

th  and the jth rows 
respectively). 

• swaprow(A,i,j);   # Interchange the row i and row j of matrix A  
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• delrows(A,i..j);    # Return the submatrix of the matrix A, which is  
                             # obtained by deleting rows i through j  

• addrow(A,i,j,c);  #Return a copy of the matrix A in which  
                            #row rj is replaced by c*row(A, ri) + row(A, rj).  

Example: Interchanging Matrix Rows.  

First define a matrix A, then interchange its 1st and 2nd rows.        

>  

 

 

>  

 

 

Example: Deleting Matrix Rows.  

First define a matrix A, then delete its row 1 through row 2 

>  

 

 

>  
 

 

Example: Adding Matrix Rows.  

First define a matrix A, then row 2 is replaced by -2*Row1+Row2.  
(Row 1 is [1 1 1] and Row 2 is [2 2 2], so  -2*Row1+Row2 is [0 0 0]) 
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>  

 
 

>  

 

 

 

         

• swapcol, addcol, and delcols act in the same way on the columns of a matrix.   

 

Matrix Algebra 
    
The most common matrix algebra operations are as follows:  

1. Single Matrix Operations  

•         inverse(A);              # Inverse of matrix A  

•         det(A);                    # Determinant of matrix A  

•         transpose(A);         # Transpose of matrix A  

•         evalm(c*A);            # Multiplying each element of matrix A by a scalar c  

 

Example: Single Matrix Operations  

>  
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>  

 
 

   >  
 

  

  >  

 

 

    >  

 

 

      2.  Multiple Matrix and Vector Operations  

•         multiply(A,v);  # Matrix-vector product A*v. The number of entries in v  
                           # must be equal to the number of columns of A   

•         evalm(A+B);  #Sum of the matrix A and B. A and B must have  
                          # the same numbers of rows and columns.  

•         evalm(A-B);   #Difference of the matrix A and B. A and B must have  
                         #the same numbers of rows and columns.  

•         multiply(A, B); #Calculate the matrix product A*B; The dimensions of  
                            #each matrix must be consistent with the rules of matrix  
                            # multiplication.  

 

  Example:  Matrix-vector product A*v.        
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       >  

 
 

   >  
 

 

    >  
 

 

 

Example: Sum and Difference of the matrices A and B  

 

     >  

             
 

 

 >  

     

 

     >  

 

 

     >  
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          Example: Matrix Product A*B  

    >  

 

 

Eigenvectors and Eigenvalues 

The linalg package also provides functions for calculating eigenvectors and eigenvalues. 

Eigenvalues 

•  Eigenvalue(A)  # return a sequence of eigenvalues of matrix A.  
 

Example: Create the expression sequence v as the eigenvalue of matrix m 

>  
 
>  

 

 

>  
 

 

Eigenvectors  

• eigenvectors(A)  # computing the eigenvalues and eigenvectors of matrix A.   

The function returns a list of sequences [ei,mi,{v[1,i],...v[ni,i]}], where ei is an eigenvalue, 
mi is its multiplicity, and {v[1,i],..v[ni,i]} is its corresponding eigenvector i .  

Example: Finding the eigenvalues and eigenvectors of matrix A  

>  

 

>  
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>  

 
 

>  

 

 

>   

 

 

>  

 

 

>  

 

 

 

Section 8. Conclusion 

The tutorial introduces you to the main functionality of Maple 11. After learning from 
this tutorial, you should be able to use Maple to do numerical computation, symbolic 
computation, 2D and 3D plotting, to create animations, and to solve problems in Calculus 
and Linear Algebra. For more information about Maple, there are Maple tutorials 
provided by Maplesoft. They are available at  

http://www.maplesoft.com/academic/students/tutorials.aspx  


